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Chapter

Introduction to the ServiceNow Events
SyncPack

Overview

This chapter describes the "ServiceNow Events" SyncPack, which is the ScienceLogic integration with the
ServiceNow Events Module. This SyncPack provides a bi-directional sync of Skylar One Events with
ServiceNow Alerts, including event creation, acknowledgment, and resolution.

This SyncPack uses the "SciencelLogic Skylar One: Event Integration" certified application in ServiceNow
and the latest "ServiceNow Base Pack" PowerPack in Skylar One.

Starting with version 1.1.0 of this SyncPack, you can use this SyncPack with or without a ServiceNow
Management, Instrumentation, and Discovery (MID) Server. Do not use the "ServiceNow Events"
SyncPack and the "ServiceNow Incident" SyncPack on the same Skylar Automation system.

This chapter covers the following topics:
What Can I Do with this SYynCPacCK? . 6

Contents of the SyncCPaCK ... . 8



What Can | Do with this SyncPack?

The "ServiceNow Events" SyncPack is the SciencelLogic integration with the ServiceNow Events Module.
This SyncPack provides a bi-directional sync of Skylar One events with ServiceNow alerts, including
event creation, acknowledgment, and resolution.

For this SyncPack, you can configure a run book action policy in Skylar One to ensure that whenever
Skylar One detects a new, acknowledged, or cleared event, a corresponding event is created or updated
in ServiceNow. These automations are included in the latest "ServiceNow Base Pack" PowerPack. For
more information, see Enabling the Run Book Automation Policies in Skylar One.

The run book automation policies could use considerable Skylar One resources if you
configure the policies to trigger the "ServiceNow: Add/Update/Clear Event" action for
every single Skylar One event. To avoid this, you will need to manage your event policies
and ensure that your Skylar One instance is sized appropriately to handle the resources
required for syncing events to ServiceNow. SciencelLogic recommends only forwarding
actionable events from Skylar One to ServiceNow through Skylar Automation. Non-
actionable events, including "Notice" and certain "Minor" events should be filtered
depending on the needs of your organization.

Starting with version 1.1.0 of this SyncPack, you can use this SyncPack with or without a ServiceNow
Management, Instrumentation, and Discovery (MID) Server.
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The following diagram details the workflow and architecture for the bi-directional sync of Skylar One
Events with ServiceNow Alerts, including event creation, acknowledgment, and resolution:

Create/Update/Clear ServiceNow Event from SL1 Event Workflow
ServiceNow Event Automation
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e, e
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update the Event in SL1
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the ServiceNow Alert
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e : 1
sitiSciencelogic SLScienceLogic

NOTE: This diagram is for environments that use a ServiceNow MID Server.

This SyncPack includes the following applications, which you can use to synchronize event information
between Skylar One to ServiceNow:

» Create Event in ServiceNow from Skylar One Event. Transforms Skylar One event data into a
ServiceNow event, and then posts that event to ServiceNow.

» Process and Cache Skylar One Events. The "ServiceNow: Add/Update/Clear Event" Run Book
Action triggers this application whenever a Skylar One event is created, updated, or cleared. This
application processes the Skylar One event and caches it to PowerFlow to allow for bulk processing
for ServiceNow by the "Sync Cached Skylar One Events to ServiceNow" application.

« Sync Alert Details from ServiceNow to Skylar One Events. Acknowledges or clears Skylar One
events from ServiceNow, updates the user note, and populates the alert number in the external ticket
reference. This application also includes the user_note_template field that accepts a Jinja2 template
to generate custom user notes. Sciencelogic suggests that you schedule this application to run
every 60 seconds. Also, you need to run the "Cache Skylar One Users" application before running
this application.

» Sync Cached Skylar One Events to ServiceNow. Bulk processes all of the cached Skylar One
events and posts them to ServiceNow. Sends a "Sync Success" or "Sync Failed" status update to
PowerFlow based on the result of the post. SciencelLogic suggests that you schedule this application
to run every 60 seconds.

« Update Skylar One Event from ServiceNow Trigger. Updates or clears a Skylar One Event based
on a ServiceNow action.
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For more information, see Configuring the PowerFlow Applications for Event Sync.

Contents of the SyncPack
This section lists the contents of the "ServiceNow Events" SyncPack.

Skylar Automation Applications

The following applications are included with the "ServiceNow Events" SyncPack:

» Create Event in ServiceNow from Skylar One Event. Transforms Skylar One event data into a
ServiceNow event, and then posts that event to ServiceNow.

» Process and Cache Skylar One Events. The "ServiceNow: Add/Update/Clear Event" Run Book
Action triggers this application whenever a Skylar One event is created, updated, or cleared. This
application processes the Skylar One event and caches it to PowerFlow to allow for bulk processing
for ServiceNow by the "Sync Cached Skylar One Events to ServiceNow" application.

* Remove Lock Documents. Removes all stale lock documents in Couchbase that were created by
the “Process and Cache Skylar One Events” application. This is a hidden application.

IMPORTANT: This application needs to be scheduled to run to clean up all the stale lock documents.
See the Configuring the Remove Lock Documents Application section for more
information.

» Sync Alert Details from ServiceNow to Skylar One Events. Acknowledges or clears Skylar One
events from ServiceNow, updates the user note, and populates the alert number in the external ticket
reference. This application also includes the user_note_template field that accepts a Jinja2 template
to generate custom user notes. Sciencelogic suggests that you schedule this application to run
every 60 seconds. Also, you need to run the "Cache Skylar One Users" application before running
this application.

» Sync Cached Skylar One Events to ServiceNow. Bulk processes all of the cached Skylar One
events and posts them to ServiceNow. Sends a "Sync Success" or "Sync Failed" status update to
PowerFlow based on the result of the post. SciencelLogic suggests that you schedule this application
to run every 60 seconds.

» Update Skylar One Event from ServiceNow Trigger. Updates or clears a Skylar One Event based
on a ServiceNow action.

For more information about configuring and running these applications, see Configuring the Applications
for Event Sync.

Configuration Object
» ServiceNow Events SyncPack. Version 1.1.0 and later of this SyncPack includes this example

configuration object, which you can use to create an event-specific configuration object for your
PowerFlow system.
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Steps

» Compare ServiceNow and Skylar One Events

e Convert SciencelLogic Event Data to SNOW Event
* Process and Cache Event

» Process and Post Event to ServiceNow

» Process Event Trigger from ServiceNow

Pull and Process ServiceNow Alerts

Contents of the SyncPack



Chapter

Installing the Events SyncPack

Overview

This chapter describes how to install the "ServiceNow Events" SyncPack and the other applications
needed to use the SyncPack, including the "SciencelLogic Skylar One: Event Integration" application and
the "ServiceNow Base Pack" PowerPack.

This chapter covers the following topics:

Skylar One and ServiceNow Terminology ... 11
Dependency Map for ServiceNow SyncPacks ... . ... . ... 11
Prerequisites for ServiceNow SyncPacks ... ... ... ... . 11
Downloading and Installing the SyncPack ... 12
Installing the ServiceNow Base Pack PowerPack in SkylarOne ...................................... 14
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Skylar One and ServiceNow Terminology

The following table lists the different names for the shared elements in Skylar One and ServiceNow:

Skylar One
Asset, Custom Attribute

ServiceNow
Asset (ITAM)

Device

CI (Configuration Item)

Discovery Session

Service Request, Catalog Request

Event Incident, Event, or Case (depending on
the SyncPack you are using)
Alert Event

Organization

Company, Domain

Schedule, Maintenance Schedule

Change Request, Change Schedule

Topology, Relationships, Dynamic
Component Mapping and Relationships
(DCM+R)

Dependency View, Affected Cls

Dependency Map for ServiceNow SyncPacks

The following graphic describes which SyncPacks depend on other SyncPacks:

I

ServiceNow Change Management

i i v v
ServiceNow CMDB ServiceNow Incident

TIP: For more information about the "Base Steps" SyncPack, see Default SyncPacks.

Prerequisites for ServiceNow SyncPacks

This section describes the prerequisites for the ServiceNow SyncPacks. For more information about the
specific software versions required by a ServiceNow SyncPack, see the latest release notes for this
SyncPack on the SyncPack Manuals and Release Notes page.

11
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To install any of the SciencelLogic ServiceNow SyncPacks, you must have administrator access to both
Skylar One and ServiceNow. Specifically, you will need:

» Sciencelogic administrator access to the Administration Portal

e ServiceNow administrator access

TIP: If you want to upload and install multiple ServiceNow SyncPacks at the same time, you should
upload all of the SyncPacks first, and then install them to address any dependencies between the
SyncPacks.

The following table lists the port access required by Skylar Automation and this SyncPack:

Source IP Skylar Automation  Skylar Automation  Destination Port Requirement
Destination Source Port
Skylar Automation |Skylar One API Any TCP 443 Skylar One API
Access
Skylar Automation |ServiceNow API Any TCP 443 ServiceNow
API Access

NOTE: Sciencelogic highly recommends that you disable all firewall session-limiting policies.
Firewalls will drop HTTPS requests, which results in data loss.

Downloading and Installing the SyncPack

A SyncPack file has the .whl file extension type. You can download the SyncPack file from the
Sciencelogic Support site.

NOTE: If you are installing or upgrading to the latest version of this SyncPack in an offline
deployment, see Installing or Upgrading in an Offline Environmentto ensure you install any
external dependencies.

To locate and download the SyncPack:

1. Go to the Sciencelogic Support Center at https://support.sciencelogic.com/s/.

2. Go to the SyncPacks page (Skylar Automation > SyncPacks).

3. Inthe Search field, search for the SyncPack and select it from the search results. The Release
Version page appears.

4. On the [Files] tab, click the down arrow next to the SyncPack version that you want to install, and
select Show File Details. The Release File Details page appears.

5. Click the [Download File] button to download the SyncPack.
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After you download the SyncPack, you can import it to your Skylar Automation system using the Skylar
Automation user interface.

Importing the SyncPack

NOTE: You mustimport and install the "ServiceNow Base" SyncPack before uploading and installing
this SyncPack.

To import a SyncPack in the Skylar Automation user interface:

1. Onthe SyncPacks page (©) of the Skylar Automation user interface, click [Import SyncPack].
The Import SyncPack page appears.

2. Click [Browse] and select the .whl file for the SyncPack you want to install. You can also drag and
drop a .whil file to the Import SyncPack page.

3. Click [Import]. Skylar Automation registers and uploads the SyncPack. The SyncPack is added to
the SyncPacks page.

4. You will need to activate and install the SyncPack in Skylar Automation. For more information, see
the following topic.

NOTE: You cannot edit the content package in a SyncPack published by SciencelLogic. You must
make a copy of a SciencelLogic SyncPack and save your changes to the new SyncPack to
prevent overwriting any information in the original SyncPack when upgrading.

Installing the SyncPack

WARNING: If you are upgrading to this version of the SyncPack from a previous version, make a note
of any settings you made on the Configuration pane of the various Skylar Automation
applications in this SyncPack, as these settings are not retained when you upgrade.
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To activate and install a SyncPack in the Skylar Automation user interface:

1. Onthe SyncPacks page of the Skylar Automation user interface, click the [Actions] button ( : ) for

the SyncPack you want to install and select Activate & Install. The Activate & Install SyncPack
modal appears.

NOTE: If you try to activate and install a SyncPack that is already activated and installed, you
can choose to "force" installation across all the nodes in the Skylar Automation system.

TIP: If you do not see the SyncPack that you want to install, click the Filter icon (=) on the

SyncPacks page and select Toggle Inactive SyncPacks to see a list of the imported
PowerPacks.

2. Click [Yes] to confirm the activation and installation. When the SyncPack is activated, the
SyncPacks page displays a green check mark icon (& ) for that SyncPack. If the activation or

installation failed, then a red exclamation mark icon () ) appears.

3. For more information about the activation and installation process, click the highlighted version in the
Installed SyncPack column for that SyncPack. For a successful installation, the "Activate & Install
SyncPack" application appears, and you can view the Step Log for the steps. For a failed installation,
go to the hidden "activate & Install SyncPack" application on the Applications page and check the
step logs.

4. If you have other versions of the same SyncPack on your Skylar Automation system, you can click
the [Actions] button ( # ) for that SyncPack and select Change active version to activate a different

version other than the version that is currently running.

Installing the ServiceNow Base Pack PowerPack in
Skylar One

The "ServiceNow Base" Pack PowerPack version 103 or later contains run book automations that you use
to integrate with the ServiceNow Events module.

TIP: By default, installing a new version of a PowerPack overwrites all content in that PowerPack that
has already been installed on the target system. You can use the Enable Selective PowerPack
Field Protection setting in the Behavior Settings page (System > Settings > Behavior) to prevent
new PowerPacks from overwriting local changes for some commonly customized fields. For more
information, see the section on Global Settings.

To install the "ServiceNow Base Pack" PowerPack:

1. Search for and download the PowerPack from the PowerPacks page at the SciencelLogic Support
Center (Skylar One > PowerPacks, login required).
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2. In Skylar One, go to the PowerPacks page (System > Manage > PowerPacks).

3. Click the [Actions] button and choose Import PowerPack. The Import PowerPack dialog box
appears.

4. Click [Browse] and navigate to the PowerPack file from step 1.

5. Select the PowerPack file and click [Import]. The PowerPack Installer modal displays a list of the
PowerPack contents.

6. Click [Install]. The PowerPack is added to the PowerPacks page.

NOTE: If you exit the PowerPack Installer modal without installing the imported PowerPack, the
imported PowerPack will not appear in the PowerPacks page. However, the imported
PowerPack will appear in the Imported PowerPacks modal. This page appears when you
click the [Actions] menu and select Install PowerPack.
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Chapter

Configuring Applications for the Events
SyncPack

Overview

This chapter describes how to configure the bi-directional Event Sync between ServiceNow and Skylar
One.

If you are configuring multipleSkylar One servers to sync with a single ServiceNow instance, see
Additional Considerations for Multiple Skylar One Systems.

This chapter covers the following topics:

Workflow for Configuring the SyncPack ... .. . 17
Configuring ServiceN OW 18
Configuring the ServiceNow MID Server ... .. . 19
Configuring SKylar One . 28
Configuring Skylar AUtomation ... .. 39
Additional Considerations for Multiple Skylar OneSystems ... 48
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Workflow for Configuring the SyncPack

The following workflows cover how to configure ServiceNow, Skylar One, and Skylar Automation to work
with Event Sync.

Configuring ServiceNow

1. Install the ServiceNow Event Management plugin

2. |Install the "SciencelLogic Skylar One: Event Integration" (Scoped) application

Configuring the ServiceNow MID Server (if needed)

NOTE: Starting with version 1.1.0 of this SyncPack, you can configure Event Sync without a
ServiceNow MID Server. If you are not using a MID Server, skip the following section and go
to Configuring Skylar One, below.

Install the MID Server

Configure the Connector Definitions

Configure the Connector Instance

Configure the MID Web Server

Configure the MID WebService Event Collector
Start the MID Web Server and the Event Collector

Run an external test of the MID Server configuration

© N o g bk 0w b=

Review the MID Server Script Include (SciencelLogic_JS)

Configuring Skylar One

1. Create a ServiceNow credential in Skylar One
2. Enable and customize the following run book automation policies:
» ServiceNow: [Events] - Add/Update
¢ ServiceNow: [Events] - Event Acknowledged
» ServiceNow: [Events] - Event Cleared
Enable the "ServiceNow: Add/Update/Clear Event" run book action
Optionally, send custom data to ServiceNow using the pass-through option

Optionally, enable the "ServiceNow: [Events] - Click to Create" automation policy

o a0 o

Optionally, enable run book automation queue retries
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Configuring Skylar Automation

1. Create a configuration object in the Skylar Automation user interface

2. Align the new configuration file with the Skylar Automation applications

3. Configure the Skylar Automation applications, depending on your ServiceNow setup:
» Configure the applications for ServiceNow with a MID Server

e Configure the applications for ServiceNow without a MID Server

Configuring ServiceNow

As a prerequisite for running Event Sync, you will need to install the ServiceNow Event Management
plugin (com.glideapp.itom.snac). You can request this plugin directly from ServiceNow.

NOTE: If you are not using a MID Server in ServiceNow, you will need to add the x_sclo_
powerflow.user and evt_mgmt_admin roles to the ServiceNow user account or Integration
user.

Installing the "SciencelLogic Skylar One: Event Integration”
(Scoped) Application in ServiceNow

The "ServiceNow Events" SyncPack uses the "SciencelLogic Skylar One: Event Integration™ application
(also called the Scoped or Certified application) to sync event status updates from ServiceNow back to
Skylar One. You must install the "ScienceLogic Skylar One: Event Integration" application on your
ServiceNow instance to enable this SyncPack.

WARNING: The "SciencelLogic Skylar One: Event Integration" application requires that you have
already installed the ServiceNow Event Management plugin on the target ServiceNow
instance. You can request this plugin directly from ServiceNow. Also, the MID Server
must be configured.

NOTE: You need to have a ServiceNow HI Service Account to request this application and download
it onto your ServiceNow instance.

You first request the "SciencelLogic Skylar One: Event Integration" application from the ServiceNow Store,
and then you can install it.

To request and install the "SciencelLogic Skylar One: Event Integration” application:

1. Go to the ServiceNow Store at https://store.servicenow.com and search for "SciencelLogic Skylar
One".
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2. Select the "Sciencelogic Skylar One: Event Integration” application. The detail page for the
application appears.

3. Click the [Get] button and log in with your HI credentials.

4. After the request is approved, log in to ServiceNow as an administrator and navigate to Application
Manager (System Applications > Applications or My Company Applications).

5. Click [Downloads] in the menu header or search for "ScienceLogic".

6. Click the version drop-down for the "SciencelLogic Skylar One: Event Integration" application listing

to make sure you are using the correct version of the application that is compatible with your version

of this SyncPack.

7. Click the [Install] button for the "SciencelLogic Skylar One: Event Integration" application. The
installation is complete when the button changes to [Installed].

8. Inthe filter navigator, search for "SciencelLogic" and locate the application in the left-hand navigation

menu to verify that the application was installed. You might need to log out of ServiceNow and log
back in to see the updated left-hand navigation menu.

Configuring the ServiceNow MID Server

IMPORTANT: Starting with version 1.1.0 of this SyncPack, you can configure Event Sync without a
ServiceNow MID Server. If you are not using a MID Server, skip this topic and go to
Configuring Skylar One.

See the following link for instructions on installing and configuring the MID Server for your ServiceNow
instance: MID Server installation.

After you set up the MID Server, you can use the following procedures to configure the ServiceNow
MID Server to work with the ServiceNow Events SyncPack.

Configuring the MID Web Server

To configure the MID Web Server (a MID Server is required for this step):

1. In ServiceNow, install the Event Management plugin. You can request this plugin directly from
ServiceNow.

2. Navigate to Mid Server > Extensions > MID Web Server. The Mid Web Server Contexts page
appears.

3. Click [New] and complete the following fields on the new record:
e Name. Type a unique name. Required.
e HTTP/HTTPS Port. Specify a port number to listen on. The port number must be unique.

e Authentication Type: Select Basic. Currently Basic is the only supported Authentication
method. Complete the Basic Auth User and Basic Auth User Password fields with the
relevant credentials.
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« Execute on: Select a specific MID Server or Cluster of MID Servers.
e MID Server. Specify the MID Server or Mid Server Cluster you will use.

4. Click [Submit] to save the new record.

NOTE: Inthe Related Links section, the Test parameters option is not a valid test to confirm your
setup.

Configuring the Connector Definitions in ServiceNow

IMPORTANT: If you are not using a MID Server, skip this topic and go to Configuring Skylar One.

To configure the Connector Definitions used by the Update Sender transaction:

1. Navigate to Event Management > Event Connectors (Pull) > Connector Definitions. The
Connector Definitions page appears.

2. Click [New] to create a new Connector Definition.

When you create a Connector Definition, ServiceNow creates a template

MID Server Script Include with the same name and "_JS" appended at the end of
the name. This item is automatically attached to the new record in the JavaScript to
runfield after you click [Submit].

3. Inthe Namefield, type a unique name and click [Submit] to save the new Connector Definition
record. The Connector Definitions page appears.

4. Open the Connector Definition you just created and complete the following fields:

e Javascript to run. Attach the JavaScript file provided by the Certified application:
Sciencelogic Skylar One: Event Integration.

» Default schedule (seconds). Specify the time in seconds between retrieval of events, such as
"120". This field is not required for this integration specifically, but it is a required field. Events
will not be pulled when this is triggered.

« Bi-Directional. Select this option to enable ServiceNow to send Alert changes back to the
source instance. Enabling this allows Skylar One as an external monitoring system to receive
changes made in ServiceNow that are specific to Alerts.

« Alert field identifier. Set to "Message Key". The field causes the source monitoring system to
be updated.
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5. Inthe Connector Parameters section, double-click to add one or more rows using the following
parameters to enable correct formatting and communication with the source event system:

Name Example Required

application_path /api/v1/applications/update_sl1_event_from_snow_trigger |No

configuration_path /api/v1/configurations/ + Configuration Name Yes

log_level 30 (Default Log level) No

run_path /api/v1/applications/run No

sl1_userid 1 (Default user_id in Skylar One) No
NOTE: The entries that are marked as not required are supplied by default.

6. Click [Submit] to save the updated Connector Definition.

Configuring the Connector Instance in ServiceNow

IMPORTANT: If you are not using a MID Server, skip this topic and go to Configuring Skylar One.

Before you can set up a Connector Instance in ServiceNow, you need to create a ServiceNow credential
that will be used by the Connector Instance.

Creating a ServiceNow Credential

To configure the ServiceNow credential that will be used by the Connector Instance:
1. Navigate to Connections & Credentials > Credentials. The Credentials page appears.
2. Click [New].

3. Select Basic Auth Credentials. A new Basic Auth Credentials record appears.
4. Complete the following fields on the new record:

¢ Name. Type a unique name for the credential. Required.

¢ User name. Type the ServiceNow user name.

e Password: Type the ServiceNow password.
5. Click [Submit] to save the new record.

After the record is saved, open it again and check the Active field on the record.

7. Click [Update].

Configuring the Connector Instance

To configure the Connector Instance:
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1. Navigate to Event Management > Event Connectors (Pull) > Connector Instances.
2. Click [New] and complete the following fields on the new record:

¢ Name. Type a unique name. Required.

WARNING: The value of the Connector Instance Name must be the same case-sensitive
value used in the Source Instance (event_class) field. If the values do not
match exactly, the bi-directional connection will not work. In the example
below, "SciencelLogic" is the Connector Instance Name. For more
information, see External Testing of the MID Server Configuration.

¢ Connector definition. Confirm that the Connector Definition you created is associated with this
Connector Instance record.

¢ Host IP: Specify the host IP address for Skylar Automation.

¢ Credential. Select the credential for connection to Skylar Automation. For more information,
see Configuring the ServiceNow Credential.

 Bi-directional. Select this option.

3. Inthe Connector Instance Values section, ensure that the values have been configured:

Name Example Required
application_path /api/v1/applications/update_sl1_event_from_snow_trigger |No
configuration_path /api/v1/configurations/ + Configuration Name Yes
log_level 30 (Default Log level) No
run_path /api/v1/applications/run No
sl1_userid 1 (Default user_id in Skylar One) No

4. Inthe MID Servers for Connectors section, select the MID Server.
Click [Submit] to save the new record.

6. After the record is saved, open it again and click [Test Connector] to confirm the correct
configuration. This option is only available after you submit the record.

If you have a successful test connection, check the Active field on the record.
8. Click [Update].

Configuring the MID WebService Event Collector

IMPORTANT: If you are not using a MID Server, skip this topic and go to Configuring the
ServiceNow Instance.

To configure the MID WebService Event Collector:
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1. In ServiceNow, navigate to Mid Server > Extensions > MID WebService Event Listener.
2. Click [New] and complete the following fields on the new record:
¢ Name. Type a unique name. Required.

e MID Web Server Extension : Select the MID Web Server you created in Configuring the
MID Web Server.

3. Click [Submit] to save the new record.

Starting the MID Web Server and the Event Collector

IMPORTANT: If you are not using a MID Server, skip this topic and go to Configuring Skylar One.

To start the MID Web Server and the Event Listener:

1. Navigate the MID Server > Extensions > Mid Web Server and select the MID Web Server you set
up in Configuring the MID Web Server.

2. Inthe Related Links section, click the Start link.

3. Navigate to the MID Server > Extensions > MID WebService Event Listener and select the MID
WebService Event Listener you set up in Configuring the MID WebService Event Collector.

4. Inthe Related Links section, click the Start link.
5. Confirm that the MID Web Server and the MID WebService Event Listener has a Status of "Started".

External Testing of the MID Server Configuration

IMPORTANT: If you are not using a MID Server, skip this topic and go to Configuring Skylar One.

SciencelLogic recommends that you test the MID Server connection by using an external testing source
outside of ServiceNow, Skylar Automation, and Skylar One.
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1. Post a message to http://{MID_SERVER_IP}:{MID_Web_Server_port}/api/mid/em/jsonv2
2. Example body:

{

"records":

[

"source" : "Simulated",

"event class": "ScienceLogic",

"node" : "Postman",

"type" : "High Virtual Memory",
"resource" : "C:",

"severity" : "2",

"description" : "Test Event",

"ci type":"cmdb ci app server tomcat",
"message key": "Postman 109843242",

"additional info":{"name":"Create an event in snow"}

IMPORTANT: The value of the Source Instance (event_class) field must be the same case-
sensitive value used in the Connector Instance Name. If the values do not match
exactly, the bi-directional connection will not work. In the example above,
"SciencelLogic" is the Source Instance (event_class) name. For more information,
see Configuring the Connector Instances.

3. Verify that the Send resulted in an HTTPS Status 200.

Using the MID Server Script Include (ScienceLogic_]JS) in
ServiceNow

IMPORTANT: If you are not using a MID Server, skip this topic and go to Configuring Skylar One.

The MID Server Script Include is provided with the "SciencelLogic Skylar One: Event Automation"
application (also called the Certified Application), and it requires the ServiceNow Event Management
plugin (com.glideapp.itom.shac). You can request the ServiceNow Event Management plugin directly
from ServiceNow.

The MID Server Script Include contains the following main parts:
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e Test Connection
e Execute
e Update Source

Test Connection is for validating that setup is complete for returning delta changes back to the source
instance.

The Test Connection process includes the following steps:
1. The Initialize step pulls in the required functions and defines default variables.

2. The Test Connection is a two-part requirement that checks for the application and configuration
availability:

» Validates Application is available via GET HTTP request to Skylar Automation.
* Validates Configuration is available via Get HTTP request to Skylar Automation.
3. Forthe Logs step, because the script is run on the MID Server, all logs are submitted to ms.log().

Execute: The part of the Script is currently is not in use, but it runs the same process as test Connection
step. At this time the execute step does not pull down events from SciencelLogic with the MID Server
Script Include. Events are delivered using a push methodology to the MID Server Listener.

Update Source: Picks up pending updates on the Connector Update Queues (em_connector_update_
queue) table and sends them back to the configured source instance.

The Update Source process includes the following steps:
1. The Initialize step pulls in the required functions and defines default variables.
2. Builds the URL.
3. Validates the URL.
4

Pulls all Records matching even_class, source instance and connector Instance name sitting in
pending.

5. Foreach record, checks to see if the record matches the following criteria:
¢ New: Checks the Numberfield being null and a value being assigned.

*  Open: Checks for field change on the State field from Closed to a new value of Reopen or
Open.

e Closed. Checks for field change on the State field from Open or Reopen to a new value of
Closed.

e Acknowledge: Due the difference in how acknowledgments are handled in the two platforms,
the Acknowledged criteria tracks the boolean value flipping to true and will return either the
default Sciencelogic user_id of 1 or a defined user id.

6. Matching values are written to new JSON code.

7. Matching JSON code is validated to ensure that it has information that needs to be sent back to
source.

8.  Posts the Request back to Skylar Automation.

For the Logs step, because the script is run on the MID Server, all logs are submitted to ms.log().
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Event and Alert Alignment in ServiceNow

PowerFlow posts cached events to ServiceNow with an unique message Key. Events are created in
ServiceNow with the payload data from Skylar Automation. Based on the event rule conditions, the alert
gets created automatically within ServiceNow, and events align to an alert based on the message Key
unique identifier. All of the events that are aligned to an alert should have the same message Key.

A New Event Reopens a Closed Alert or Creates a New Alert Based
on the Time of the Incoming Event
In ServiceNow, go to the Event Management Properties module under the Event Management

application. On this page, you can access the Active interval (in seconds) within which a new event
reopens a closed alertfield (evt_mgmt.active_interval). In this field, you can set a time period in

seconds within which an incoming event can either re-open a closed alert or create a new alert event with

same message Key.

In the following image, this field has a value of 14400 seconds (4 hours):

Event Management Properties

Number of events to handle for event rules processes (3)

[50000 |

Page size of CIs from the Technical Service to be fetched at once while calculating Technical Service Impact Tree (3

[100 |

Enable multi node event processing (3)

[)¥es |No
Number of scheduled jobs processing events (3)
[ |

Maximum events to be processed by every scheduled job (@)

[s000 |

Number of events to process in bulk during each event processing job. (%)

[ |

Disable auto-refresh of alerts list; alerts will update in Workspace only when user does so manually. (3)

[¥es | No

Enable alert group support (3)

ges | No

Include alerts with maintenance flag set in alert console (%)

[T¥es | No.

Auto close interval (in hours), within which open alerts will be automatically closed; Setting the property to 0 will disable this feature but it is not recommended. (%)

| 168 |

Active interval (in seconds), within which a new event reopens a closed alert (3)

[14400 |

You can configure these properties for each customer instance. You can have two different alerts with the

same message Key. Consider the following scenarios:

* When an event clear occurs to close the alert associated to it, and the next open event occurs withi
4 hours (based on the setting in the image above), then this event would re-open the same alert.

* When an event clear occurs to close the alert associated to it, and the next open event occurs after
hrs, then this event would not re-open the same alert. Instead, a new alert is created with the same
message Key.
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The following image shows an example of the second scenario:

In the above example, a clear event came in and closed the corresponding alert, Alert1901706 at 2023-
01-01 12:00:42. The next open event that triggered with the same message Key was at 2023-071-01
21:24:16. The time difference was more than 4 hours, so as a result, this event created a different alert ,
Alert1905924 and did not re-open Alert1901706.

Fix Scripts to Validate the Above Scenarios in ServiceNow

When you have large-scale data in event and alert tables in ServiceNow, it can be difficult to manually test
the alignment of events and alerts, as well as alerts re-opening or creating a new alert, as mentioned in
the scenarios, above.

To address this issue, Sciencelogic created Fix Scripts that you can use to validate the output and see if
there are any misconfigured event/alert alignment or any mismatched alert re-openings.

To validate the event alert data, the following Fix Script checks to see if events that are aligned to alerts
have the same message Key; if not, the script it pulls misconfigured alert numbers and Event sysIDs and
creates a .CSYV file with this data and attaches it to the same fix script. You can look at the .CSV file to
check if there are any misconfigurations.
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To validate alert re-openings, the following Fix Script checks for the date/time differences between alerts
with same message Key. The Script pulls out any misconfigured alerts, creates a .CSV file with this data,
and attaches it to the same Fix Script. You can look at the .CSV file to check if there are any
misconfigurations for the alert re-opening/new alert scenario.

Configuring Skylar One

The following topics cover how to set up your Skylar One instance for Event Sync.

IMPORTANT: You must install the latest "ServiceNow Base Pack" PowerPack before you can
perform the following procedures. For more information, see Installing the ServiceNow
Base Pack PowerPack.

Creating a ServiceNow Credential in Skylar One

To configure Skylar One to communicate with ServiceNow, you must first create a SOAP/XML credential.
This credential allows the run book automations in the "ServiceNow Base Pack" PowerPack to connect
with your ServiceNow instance. These run book automations are responsible for sending the Skylar One
event data to Skylar Automation, which ultimately sends the data to ServiceNow.

The ServiceNow RBA - Example credential from the "ServiceNow Base Pack" PowerPack is an example
SOAP/XML credential that you can configure for your own use.

To configure the ServiceNow RBA - Example credential:
1. In Skylar One, go to the Credential Management page (System > Manage > Credentials).
2.  Locate the ServiceNow RBA - Example credential and click its wrench icon ( E!ﬂ). The Edit
SOAP/XML Credential page appears.
3. Complete the following fields:
* Profile Name. Type a new name for the ServiceNow credential.

+ Timeout. Leave as the default of "5000" ms.
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e Content Encoding. Make sure text/xmlis selected.

* Method. Make sure POST is selected.

e HTTP Version. Select http/1.1.

¢ URL. Type the URL for your Skylar Automation instance.

e HTTP Auth User. Type the username of your Skylar Automation instance.

e HTTP Auth Password. Type the password of your Skylar Automation instance.
4. Click [Save & Close]. The credential is added to the Credentials page

5. Onthe Credentials page, make a note of the value in the ID column for the credential you just
created. You will use this value with the sl1_credential_id parameter when you enable the snippet
code of the "ServiceNow: Add/Update/Clear (Case/Event/Incident)" run book action policy.

Enabling the Run Book Automation Policies in Skylar One

NOTE: Versions 104 and later of the "ServiceNow Base Pack" PowerPack separated these run book
action policies by Cases, Events, and Incident, such as "ServiceNow: [Events] - Add/Update".

Before you can run the "ServiceNow: Add/Update/Clear Event" run book action, you must enable the
three event-specific run book automation policies in Skylar One:

e ServiceNow: [Events] - Add/Update
« ServiceNow: [Events] - Event Acknowledged

e ServiceNow: [Events] - Event Cleared

These run book automation policies could use considerable Skylar One resources if you
configure the policies to trigger the "ServiceNow: Add/Update/Clear Event" Action for
every single Skylar One event. To avoid this, you will need to manage your event policies
and ensure that your Skylar One instance is sized appropriately to handle the resources
required for syncing events to ServiceNow. SciencelLogic recommends only forwarding
actionable events from Skylar One to ServiceNow through Skylar Automation. Non-
actionable events, including "Notice" and certain "Minor" events should be filtered
depending on the needs of your organization.

To enable the three ServiceNow run book automation policies:

1. In Skylar One, go to the Automation Policy Manager page (Registry > Run Book > Automation).

2. Locate the "ServiceNow: [Events] Add/Update" automation policy and click its wrench icon ( IF'1:').
The Automation Policy Editor page appears.
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3. Update the following fields:
¢ Policy State. Select Enabled.

« Policy Priority. Select High to ensure that this Skylar Automation automation policy is added to
the top of the queue.

e Auvailable Actions. If it is not already selected, select the corresponding ServiceNow run
book action policy and add it to the Aligned Actions column.

WARNING: ScienceLogic highly recommends that you do not make changes to the
Policy Type, Repeat Time, or Align With fields or the And event is NOT
acknowledged setting.

4. Click [Save].

5. Repeat steps 2-4 for the "ServiceNow: Event Acknowledged" and "ServiceNow: Event Cleared" run
book automation policies.

Enabling and Customizing the Run Book Action Policy

The "ServiceNow: Add/Update/Clear Event" run book action policy contains several default values in the
snippet code for the policy that you can customize to use with the "ServiceNow Events" SyncPack.

You can edit these values in the Input Parameters pane of the Actions page for this policy.

NOTE: Make sure you are using the most recent version of the run book action policy. If there are two
policies with the same name, always use the policy with the higher number in the ID column of
the Actions page.
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To enable and customize the Event run book action policy:

1. In Skylar One, go to the Actions page (Registry > Run Book > Actions).

2. Locate the ServiceNow: Add/Update/Clear Event policy and click its wrench icon ( JE'ﬂ). The
Action Policy Editor page appears:

Policy Editor | Editing Action [47]
Action Name Action State
[ServiceNow: Add/\Update/Clear Event || (Enabled |
De=scription

[.-'-\dds, Updates, or Clears Alerts in ServiceMow. Events SyncPack 1.1.0+ ]

Organization Action Type
[ [ System ] w ] |serviceNow: Send to PowerFlow (1.1) |
Execution Environment Action Run Context
[[-— Default: ServiceMow Base Pack (python2) | w ] [[Database] -
Input Parameters
{
I "s11 credential id™: “la7", I
debug™: o
"configuration™: "<configuration id from PowerFlow:",
"queue™: "7,

"emdb_integration™:"sGC",

"integration”: "events",

"events_mid_server™: 5

"message_key template”: "{{'{}'.format{event.event_id)}}"

For the Action State filed select Enabled.

4. Forthe sl1_credential_idfield in the Input Parameters pane, specify the credential ID form the ID
column on the Credential Management page (System > Manage > Credentials). For example:
"sll credential id": "107"

5. Inthe Input Parameters pane, edit the snippet code as necessary, using the information in the
Customizing the Snippet Code in the Input Parameters Pane section, below.

6. When you are finished, click [Save].

Customizing the Snippet Code in the Input Parameters Pane

Skylar One run book action snippets are written in Python. In the event of a syntax error, the policies will
no longer run. As a result, you must ensure that all edits adhere to Python standards. True and False
options are case-sensitive and must not contain quotes.
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NOTE: Make sure you are using the most recent version of the run book action policy. If there are two
policies with the same name, always use the policy with the higher number in the ID column of
the Actions page.

You can customize the following values in the "ServiceNow: Add/Update/Clear Event" run book action
snippet code:

» sl1_credential_id. Specifies the ID of the credential object. You can find this value in the ID column
of the Credentials page (System > Manage > Credentials of Skylar One. For example: "s11
credential id": "101"

» debug. A true/false value that determines if the action is logged in Skylar One and if the application
is run in Debug Mode on Skylar Automation. Troubleshooting logs are written to
/data/tmp/servicenow_rba.log.

» configuration. Specifies the ID of the configuration object used on Skylar Automation. The
configuration ID is all lower-case, with spaces in the configuration object "friendly" name replaced
by underscores. For example: "configuration": "docs configs".

NOTE: To find the configuration ID with the Skylar Automation API, make a GET request on this
endpoint: https://<PowerFlow service
hostname>/api/vl/configurations.

e queue. Specifies the worker queue on which the application runs. Leave this as default.

* discard_if_no_ci. Deprecated. Previous versions let you specify whether Skylar Automation should
create cases, events, or incidents in ServiceNow for devices that do not have a matching Cl record.

» cmdb_integration. Specifies which CMDB SyncPack you are using to ensure that Skylar Automation
sends the correct identifiers to ServiceNow.

° If you are using the "ServiceNow CMDB" SyncPack version 3.5.0 or later, use "SGC" to allow
Cls to attach to incidents. For example: "cmdb integration™:"SGC"

° If you are using versions of the "ServiceNow CMDB" SyncPack before version 3.5.0, use
"CMDB".

° If you are using the "ServiceNow Service Graph Connector" SyncPack, use "SGC".

» integration. Specifies the SyncPack you are using for this run book action. For example:
"integration": "events".

e events_mid_server. Set this field to true if you are using a ServiceNow MID Server with the Event
Sync, or set it to false if you are not using a MID Server.

* message_key_template. This field lets you customize the message key used by PowerFlow to
correlate Skylar One events with ServiceNow alerts. This field is used with the Event Sync.

° Bydefaultthe valueis "{{'{}'.format (event.event id)}}", which createsa
ServiceNow alert for each Skylar One event; this is the existing MID Server flow behavior.
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° Asuggested alternative valueis " { { ' { } +EVENT+{ } ' . format (event.node
id,event.event policy id) }}", which groups the events by parent entity, such as
device or interface, and event policy ID. The Skylar One region used in the aligned
configuration object in PowerFlow will be prepended to this value to ensure it is unique across
stacks.

TIP: If you are using the MID Server and you use the message_key_template field to configure a
message key with a one-to-many correlation between a single ServiceNow alert and multiple
Skylar One events, you should schedule the "Sync Alert Details from ServiceNow to Skylar One
Events" PowerFlow application to run, with the events_mid_server parameter selected on the
Configuration pane for the "Sync Alert Details" application. These settings ensure that the ext_
ticket_refis populated when the ServiceNow alert re-opens. If you are using a message key with
a one-to-one relationship between alerts and events, you do not heed to schedule the "Sync Alert
Details from ServiceNow to Skylar One Events" application.

« disable_tls. The default value for this variable is false. Set this field to true if you want to disable
TLS verification.

Customizing Logging in the Run Book Action

You can customize the following logging-related items in the "ServiceNow: Add/Update/Clear Event" run
book action snippet code:

e logfile = /data/tmp/ServiceNow add update clear incident.log
° Location for logging output.
°  Will be created if it does not exist.
°  Will be appended with each run book job.
° |s case-sensitive.
e do debug logging = True
° Trueison, False is off.
° |s case-sensitive.
° For troubleshooting, these can be enabled or changed.

° Writes logs to /data/tmp/servicenow_rba.log.
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Sending Custom Data to ServiceNow Using the Passthrough
Option (Optional)

Passing Custom Data to ServiceNow

You can use the "ServiceNow: [(Cases/Events/Incidents)] Add/Update" run book automation and the
"ServiceNow: Add/Update/Clear (Case/Event/Incident)" run book action to "pass through" custom data
about Skylar One cases, events, or incidents to ServiceNow (depending on the SyncPack you are using
with Skylar Automation).

For example, you might want to use the passthrough functionality to overwrite the impact and urgency of a
ServiceNow incident, which is the only way to change the priority of the incident.

To pass custom data to ServiceNow:

» Create a new run book action that pulls the relevant data and adds it to a dictionary called EM7_
RESULT.

» Add the new run book action to the "ServiceNow: [(Cases, Events, or Incident)] Add/Update " run
book automation Policy, ahead of the "ServiceNow: Add/Update/Clear (Case/Event/Incident)" run
book action so that the new action runs first, and then is consumed by the ServiceNow action.

Passing Custom Data to ServiceNow

The following procedure describes how to configure the passthrough functionality, using the "ServiceNow:
[Incident] Add/Update" run book automation and the "ServiceNow: Add/Update/Clear Incident' run book
action as examples.

To pass custom data to ServiceNow:

1. In Skylar One, go to the Actions page (Registry > Run Book > Actions) and click [Create] to create
a new run book action policy.

2. Complete the following fields:
¢ Action Name. Type a unique name for the action.
 Action State. Select Enabled.
¢ Action Type. Select Run a Snippet.
« Execution Environment. Select ServiceNow Base Pack.
¢ Complete the other fields as needed, or leave them at their default settings.

3. Inthe Snippet Code pane, add the snippet code you want to include for the EM7_RESULT
dictionary. For example, the following snippet code lets you override the ServiceNow Incident work
notes with a hardcoded note:

EM7 RESULT = {"work notes": "This is a new note"}

Additional notes about the structure of the EM7_RESULT dictionary:

e EM7 RESULT = is required for the dictionary, and the formatting of the keys should match the
example above.
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All keys defined in the EM7_RESULT dictionary need to map to field IDs on the SciencelLogic
Events table in ServiceNow.

You can hard-code the values in the EM7_RESULT dictionary, or you can use variables and
functions, like the "Snippet Code Example”, below.

As a best practice, avoid sending null passthrough values to ServiceNow. If you must send
'null' or 'NULL' values to ServiceNow, pass through that value as an empty string, such as

"location":"". Also, only pass through values that you need. For example, instead of
sending {"location": "", "work notes": "stuff"},simplysend {"work
notes": "stuff"}.

A long snippet might delay the ticket being created

Click [Save].

5. Go to the Automation Policy Manager page (Registry > Run Book > Automation) and open the
"ServiceNow: Add/Update Incident" run book automation Policy.
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6. Inthe Available Actions section, add the new run book action before the "ServiceNow: Create,
Update, Clear Incident" run book action:

Automation Policy Editor | Creating New Automation Policy

Policy Name Pobey Type Policy State Policy Prionty Crganizabion

Serviatiow ASdUpdate incident [Actve Events | ¥ | | [ Enabled | ¥ | |[High] ¥ | I System ] Y
Coleria Logic Makch Logic Maich Syniax

[ Seventy e ] v | [ Major | v | |[Textsearch] v

ENWNM*WE S Repeal Time Align With

| snce the fust occumence. | ¥ | [[Ontyence] v | [{Devices ] v

[ and event 5 NOT cleared | ¥

» Inciude events for entites other than denices (CrpancIBons assels el

[ and afl times are vaid |

¥ Trgger on Chid Rolup

Avalable Devces Adgned Devces
(Al devices)

System -
Servicelion Instance ven(144 ﬂ

Avallable Events Algned Events
(Al events)

[3569] Cocai AKCP AC Veitage sensor delects no cumend .

[3578] Crtical AKCP. DC Viollage sensor High Criscal u

[3579] Critcal AKCP: DC VioRlage sensor Low Critcal

[3568] Critical. AKCP:. Dry Contact Sensor Low Criscal n

[3574] Critical AKCP: Smoice Detecior Alert

[3572] Comcal AKCP. Waler Sensor has deleched waler -

Avalable Acdons Abgned Ackons

27

|2. Senvicehiow: Create, Update, Clear Incident [100] Se

Cco VOS Node Classiication and Cluster Crea
] Dell EMC: Unity Classify Roct Device Cliss
] Dall EMC: VIAX Unisphere Classify Root Device
) EMT Ping Snippet
Soippet [5]: Exampie Passttvough EMT_RESULT >

ETmETTS

I Caco: VOS Carrownlol’h:ﬂu Mg - H

NOTE: The output of this new run book action will be consumed by the "ServiceNow: Create,
Update, Clear Incident" run book action, ensuring that the EM7_RESULT dictionary is
passed through to ServiceNow. The "ServiceNow: Create, Update, Clear Incident" run
book action automatically populates the passthrough values with any values from EM7_
LAST_RESULT. The passthrough overwrites any other previously defined fields, such
as assignment group.

7. You can add additional run book actions to the run book automation Policy for any additional
workflows that you might want to run. The Automation Policy execute these Actions in a sequential,
top-down order. However, the "ServiceNow: Create, Update, Clear Incident" run book action only
consumes the EM7_RESULT dictionary from the run book action directly above it.

Passthrough Example

For the Dictionary Entry of the ServiceNow field on the import table, you can reference the XML of the
record. You will need to copy the <sys name> value so you can use that as the key for the passthrough.

In this example, you want to bring in an additional field called s/7 category.
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1. Create the new s/7 category field on the import table in ServiceNow. You can right-click on the
header of the form to view the XML:

= Dictionary Entry @
sl category. é

becomes the field labe

elect a Table and the field Type of the new eolumn. Also enter s column lat
ue for reference fields 50 it appears on records that reference this table. v

Adictionary entry manages how ServieeNow stores data in tables and fields (columns). For new dictionary
3 Max length for text String type fields, make the field Mandatory to save a record, and make the field a Dis

% Table Sciencelogic Incident import [x sclo_incide... ~ o

* Type | String a|
¥ Columnlsbel | i1 category
* Columnname  u_si1_category

* Maxlensth 24

Choice List Specification | Default Value

Displays 2 list of suggested values in a Choice list. In the Advanced view you can select the Choice table ai

Choice | -~None

Delete C

Related Links

s

Access Controls | Cholces | Atiributes | Labels(2)

2. Lookforthe <sys name>value.

3. Copy that value directly out and use that in your EM7_RESULT for the passthrough value (in the
Snippet Code pane):

EM7 RESULT = {'sll Category': 'test'}

Snippet Code Example

The following snippet code example shows how to pull additional information and make it available for
passthrough. All of the additional information that is going to be sent is contained in a dictionary variable
called EM7_RESULT. You can pass through multiple items through in a single run book action by adding
additional keys to the EM7_RESULT dictionary.

This example lets you assign assignment groups to an Incident based on certain criteria, such as event
policy IDs:

from future.utils import iteritems

def invert mappings (mappings) :

mmon
Invert received one-to-many mappings and converts it into a one-to-one

mapping.

Args:
mappings (dict): Dictionary of mapped values

Returns:

dict: inverted dictionary.

wun
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inverted mappings = dict()
for key, values in iteritems (mappings) :
for sub value in values:
invert mappings[sub_value] = key

return inverted mappings

# Example of assignment group to list of event policy ids mapping.

assignment groups to event policies = {
"sys_id 1": [1, 2, 3, 4, 51,
"sys_id 2": [6, 7, 8, 9, 10],

}

# which sys id to use if the current event policy id isn't mapped

default sys id = "sys id 3"

# invert the mappings
event policy to assignment group = invert mappings (assignment groups to

event policies)

# Send assignment group sys id to IS RBA
EM7_RESULT = {
"assignment group": event policy to assignment group.get (

EM7 VALUES["%3"], default sys id

Enabling the "ServiceNow: [Events] - Click to Create”
Automation Policy (Optional)

The "ServiceNow: [(Cases/Events/Incident)] - Click to Create" automation policy lets you manually create
a case, event, or incident in ServiceNow by clicking the Actions button (: ) in Skylar One for an event and

selecting "Create External Ticket" (or by clicking the life-preserver icon (&) for an event in the classic user
interface).

This run book action policy is available in the "ServiceNow Base Pack" PowerPack.
To configure the "ServiceNow: Click to Create" run book action policy:

1. In Skylar One, go to the Behavior Settings page (System > Settings > Behavior) and set the Event
Console Ticket Life Ring Button Behavior option to Create/View External Ticket.

2. Click [Save] to save your changes. You might need to log out of Skylar One and log back into
Skylar One for the changes to update.

3.  Go to the Automation page (Registry > Run Book > Automation).
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4. Locate the "ServiceNow: (Cases/Events/Incident) - Click to Create" policy and click its wrench icon
(). The Automation Policy Editor page appears:

5.  Update the following fields:
¢ Policy State. Select Enabled.

« Inthe Criteria Logic section, select and external ticket IS requested in the fifth drop-down.
Leave the other values in this section at their default settings.

* Repeat Time. Specify the frequency at which Skylar One should execute the automation
policy while the conditions are still met. The choices range from "every 30 seconds until
satisfied" to "every 2 hours until satisfied", or "only once". By default, the policy only runs once.

* Available Actions. If it is not already selected, select ServiceNow: Send to Skylar Automation:
ServiceNow: Add/Update/Clear Incident and add it to the Aligned Actions field.

6. Click [Save]. The "Click to Create" feature is now available on the Events and Event Investigator
pages.

Enabling Run Book Automation Queue Retries

You can enable run book action (RBA) queue retries to keep from losing any data if Skylar Automation is
unavailable. Those pending Skylar Automation applications are added to an RBA queue that you can
access to retry the applications that failed.

For more information, see Enabling Run Book Automation Queue Relries.

Configuring Skylar Automation

The following topics cover how to set up your Skylar Automation instance for Event Sync.

IMPORTANT: You must install the ServiceNow Events SyncPack before you can perform the
following procedures. For more information, see Installing the ServiceNow Events
SyncPack.
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Creating and Aligning a Configuration Object in
Skylar Automation

A configuration object supplies the login credentials and other required information needed to execute
the steps for a Skylar Automation application. The Configurations page ( £ ) of the Skylar Automation

user interface lists all available configuration objects for that system.

You can create as many configuration objects as you need. A Skylar Automation application can only use
one configuration object at a time, but you can use (or "align") the same configuration object with multiple
applications.

To use this SyncPack, you will need to use an existing configuration object in the Skylar Automation user
interface or create a new configuration object. Next, you need to align that configuration object to the
relevant applications that are triggered by the Run Book Actions in Skylar One.

TIP: Depending on your Skylar One environment and the third-party environment with which you are
syncing data, you might be able to use the same configuration object with more than one
SyncPack.

Creating a Configuration Object for Event Sync

For the ServiceNow Events SyncPack, you will need to make a copy of the "ServiceNow SyncPack"
configuration object, which is the sample configuration file that was installed with the "ServiceNow Base"
SyncPack. After you create the new configuration object, you will need to add specific name-value pairs
as variables for this SyncPack. These variables are listed in the following procedure.

TIP: If you have already set up a configuration object that you are using for other ServiceNow
SyncPacks, you can use that configuration object for Event Sync. Go to step 7 in the following
procedure to add the variables needed for this SyncPack.

To create a configuration object for the Events SyncPack:
1. Inthe Skylar Automation user interface, go to the Configurations page (£ ).
2. Click the [Actions] button ( : ) for the "ServiceNow SyncPack" configuration object and select Edit.
The Configuration pane appears.

3. Click [Copy as]. The Create Configuration pane appears.

4. Complete the following fields:
¢ Friendly Name. Name of the configuration object that will display on the Configurations page.
« Description. A brief description of the configuration object.
¢ Author. User or organization that created the configuration object.

¢ Version. Version of the configuration object.
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Click

[Toggle JSON Editor] to show the JSON code.

In the Configuration Data field, be sure to include the required block of code to ensure that the
applications aligned to this configuration object do not fail:

{

"encrypted": false,

"name": "sll db host",
"value": "${config.sll_host}"
}
For example:

{

"encrypted": false,
"name": "sll db host",

"value": "10.2.11.42"

NOTE: If you are using Skylar One with an External Database (Skylar One Extended architecture or a
cloud-based architecture), update the "value" of that block of code to be the host of your
database. This field accepts IP addresses. For example: "value":
"db.sciencelogic.com". If you are notusing the Skylar One Extended architecture or a
cloud-based architecture, you do not need to make any changes to the block of code other
than pasting the code into the configuration object.

7. Inthe Configuration Data field, update the default name-value pairs or add your own to match your
Skylar Automation configuration. The Events SyncPack requires the following name-value pairs as

varia

bles:

NOTE: The mid_server name-value pairs are not needed in the configuration object if your

ServiceNow configuration does not include a MID Server.
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mid_server_api_protocol. The protocol used by the API of your MID Server. The default is
http.

mid_server_host. The IP address of the ServiceNow MID Server, along with the port number
of the listener. In ServiceNow, go to the MID Web Server Contexts page (MID Server >
Extensions > MID Web Server) and select the record you are using for Event Sync. The port
number is defined in the HTTP/HTTPS Portfield (port_number) on the MID Web Server
Context record form. For example: 192.168.1.1:1773.

mid_server_user. The MID Server user account. In ServiceNow, go to the MID Web Server
Contexts page (MID Server > Extensions > MID Web Server) and select the record you are
using for Event Sync. The user is defined in the Basic Auth Userfield (basic_auth_user) on
the MID Web Server Context record form.
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e mid_server_password. The MID Server account password. In ServiceNow, go to the
MID Web Server Contexts page (MID Server > Extensions > MID Web Server) and select the
record you are using for Event Sync. The password is defined in the Basic Auth User
Password field (basic_auth_user_password) on the MID Web Server Context record form.
This is not a User on the sys_user table.

 region. Unique identifier that identifies your Skylar One instance within ServiceNow.
¢ sl1_host. The URL or IP address for the target Skylar One system.
« sl1_user. User id of the user account the Skylar Automation will use to log in to Skylar One.

« sl1_password. Password for the user account that Skylar Automation will use to log in to
Skylar One.

e snow_host. The URL for the target ServiceNow instance. For example: sciencelogic.service-
now.com.

¢ snow_user. User id of the user account that PowerFlow will use to log in to ServiceNow.

* snow_password. Password of the user account that PowerFlow will use to log in to
ServiceNow.

« snow_event_class. Unique identifier for the Skylar Automation host that specifies which
Skylar Automation host should receive updates from ServiceNow. For bi-directional
functionality to work, the connector instance name needs to match the source instance (snow_
event_class) field exactly. These fields are case-sensitive.

* mid_rel_url. The relative URL for the Events Endpoint on the MID Server. Set this value to the
following: /api/mid/em/inbound event?Transform=jsonv2.

8. If you want to use OAuth2 for authentication with ServiceNow, complete the following Configuration
Data Values fields:

e snow_oauth_client_id. Enter the OAuth2 Client ID from ServiceNow.
* snow_oauth_client_secret. Enter the OAuth2 Client secret from ServiceNow.

e snow_oauth_token_url. Enter the full authentication URL, including host and protocol from
ServiceNow. For example, "https://<test-instance-name>.service-now.com/oauth_token.do"

e snow_auth_method: Enter oauth or http_basic. If no value is provided, http_basic will be
used for connection.

NOTE: The configuration options listed above are included by default with the sample configuration
object provided in the "ServiceNow Base" SyncPack. The configuration options are only
required in the configuration object if you plan to use OAuth2 to authenticate. If the values are
not present in the configuration object, normal "http_basic" authentication will be used.

9. Click [Save]. You can now align the new configuration object with the relevant Skylar Automation
applications:

The following code is an example of the JSON configuration data for this configuration object:

[
{
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"name" :
"value":
}I
{
"name" :
"value":
b
{
"name" :
"value":
}I
{
"name" :
"value":
b
{
"name" :

"value":

"mid server api protocol",

"http"

"mid server host",

"10.2.2.150"

"mid server user",

"midserveruserexample"

"region",

"example region"

"mid server password",

"example password",

"encrypted": true

}o

{

"name" -
"value":
b

{

"name" -

"value":

"sll host",
"10.2.2.89"

"sll password",

"example password",

"encrypted": true

b

{

"name" .
"value":
}r

{

"name" -
"value":
b

{

"name" .

"value":

"sll user",

"em7admin"

"snow host",

"example.service-now.com"

"snow_event class",

"example val"
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}y
{

"name": "mid rel url",

"value": "/api/mid/em/inbound event?Transform=jsonv2"
}y

{

"name": "snow password",

"value": "snowpassword",

"encrypted": true

}y

{

"name": "snow user",
"value": "snowadmin"

}

Creating an OAuth2 Credential Record in ServiceNow

In order to use OAuth2 for authentication with ServiceNow, you must create an OAuth2 credential record
in ServiceNow. To configure the ServiceNow credential that will be used by the Connector Instance:

Navigate to System OAuth > Application Registry. The Application Registries page appears.

’
2. Click [New].
3.
4

Select Create an OAuth API endpoint for external clients. A new record appears.

. Complete the following fields on the new record:

¢ Name. Type a unique name for the credential. Required.

e Client ID. The Client ID is automatically generated by the ServiceNow OAuth server.

« Client Secret. Leave this empty. ServiceNow will auto-generate this when the record is saved.
* Refresh Token Lifespan. Enter the length of time in seconds the Refresh Token will be valid.

« Access Token Lifespan. Type the length of time in seconds that the Access Token will be
valid. Sciencelogic recommends setting this to 3,600 seconds to avoid known issues for
longer ServiceNow REST interactions.

NOTE: In ascenario where the [Access Token Lifespan] value is shorter than the duration of a

Skylar Automation step that makes multiple REST interactions with ServiceNow, the access
token will expire and need to be refreshed. As a result, retries were added to several Skylar
Automation steps where this issue may occur. This issue will hopefully be addressed in future
versions of the Base Steps SyncPack.

5.
6.

Under the Auth Scope section at the bottom of the page, double click /nsert a new row.

In the search box that appears, click the magnifying glass icon, select the useraccountrecord, and

Configuring Skylar Automation 44



click the checkmark icon to save.

7. Click [Submit] to save the new record.

@ = - |Update SO

Application Registries
PowerFlow Token View: Default*
OAuth client application details.
« Name: A unique name.
» Client ID: Client ID automatically generated by ServiceNow OAuth server.
» Client Secret: Client secret for the OAuth application. Leave it empty for auto-generation.
= Refresh Token Lifespan Time in seconds the Refresh Token will be valid.
» Access Token Lifespan: Time in seconds the Access Token will be valid.
» Redirect URL:The rediect URLs authorization server redirect to. They must be absolute URLs and they are comma separated.
» Enforce Token Restriction: Restricts the access token usage to the API 's defined in the REST AP| Access Policies. Unselecting this option would allow access token usage across other REST API's. Learn more.
More Info
* Name ‘PowerFlannken ‘ Application Global (0]
* Client|D 85abadébedB2c2507f0168b91alcibcf Accessible from | All application scopes V‘
Client Secret ‘ ---------- E] Active
Redirect URL @ 3k Refresh Token Lifespan | 8‘640,000‘
Logo URL @ >k Access Token Lifespan | 3,600 ‘
Public Client [ Login URL
Comments ‘
Auth Scopes () 1 tolof1
Auth Scope
X useraccount
Insert a new row..

Configuring the Skylar Automation Applications

for Event Sync

The workflows for configuring Skylar Automation applications for Event Sync are different based on
whether your ServiceNow environment uses a MID Server. Both workflows are included in the following

sections.

Configuring Skylar Automation Applications for ServiceNow with

a MID Server

To run Event Sync, you must "align" the configuration object to run with the following Skylar Automation

applications:

e Cache Skylar One Users

» Create Event in ServiceNow from Skylar One Event

» Sync Alert Details from ServiceNow to Skylar One Events

Update Skylar One Event from ServiceNow Trigger

NOTE: You only need to run the "Sync Alert Details from ServiceNow to Skylar One Events"
application if you use a message key in the "ServiceNow: Add/Update/Clear Event" Run Book
Action that has a one-to-many correlation between a single ServiceNow alert and multiple
Skylar One events. See the following procedure for more information.
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NOTE: If you want to link events with ServiceNow Configuration ltems (Cls), you will need to run the
"Sync Devices from Skylar One to ServiceNow" application from the "ServiceNow CMDB"
SyncPack. For more information, see Running a Device Sync.

To configure PowerFlow applications for ServiceNow with a MID Server:

1. Onthe Applications page of the Skylar Automation user interface, open the "Create Event in
ServiceNow from Skylar One Event" application and click [Configure]. The Configuration pane for
that application appears.

2. From the Configurations drop-down, select the configuration object you want to use.
3. Click [Save] to align that configuration with the application.

4. Repeat this process for the "Update Skylar One Event from ServiceNow Trigger" application and the
"Cache Skylar One Users" application. The "Cache Skylar One Users" application is in the "System
Utils" SyncPack. SciencelLogic recommends that you schedule the "Cache Skylar One Users"
application to run at least once a week.

5. Ifyou use a message key that does not have a one-to-one correlation between Skylar One events
and ServiceNow alerts, you will need to open the "Sync Alert Details from ServiceNow to Skylar
One Events" application and edit the following parameters on the Configuration pane:

e events_mid_server parameter for this application should be selected.

e user_note_template field that accepts a Jinja2 template to generate custom user notes.
6. Click [Save].
7. Sciencelogic recommends that you schedule the following Skylar Automation applications:

¢ Cache Skylar One Users: at least once a week

¢ Sync Alert Details from ServiceNow to Skylar One Events: every 60 seconds

NOTE: For more information about scheduling applications, see Scheduling a PowerFlow
Application.

Configuring PowerFlow Applications for ServiceNow without
a MID Server

To run Event Sync for ServiceNow without a MID Server, you must "align" the configuration object to run
with the following Skylar Automation applications:

» Cache Skylar One Users (from the ServiceNow Base SyncPack)
» Sync Alert Details from ServiceNow to Skylar One Events

* Sync Cached Skylar One Events to ServiceNow

e Process and Cache Skylar One Events

To configure PowerFlow applications for ServiceNow without a MID Server:
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1. Onthe Applications page of the PowerFlow user interface, open the "Sync Alert Details from
ServiceNow to Skylar One Events" application and click [Configure]. The Configuration pane for that
application appears.

2. From the Configurations drop-down, select the configuration object you want to use.

3. Foronly the "Sync Alert Details from ServiceNow to Skylar One Events" application, make sure that
the events_mid_server parameter selected is not selected.

4. Click [Save] to save the configuration settings.

Repeat steps 1-4 for the "Cache Skylar One Users" application, the "Sync Cached Skylar One
Events to ServiceNow" application and the "Process and Cache Skylar One Events" application. The
"Cache Skylar One Users" application is in the "System Utils" SyncPack.

6. Sciencelogic recommends that you schedule the following Skylar Automation applications:
¢ Cache Skylar One Users: at least once a week
¢ Sync Alert Details from ServiceNow to Skylar One Events: every 60 seconds

¢ Sync Cached Skylar One Events to ServiceNow: every 60 seconds

NOTE: For more information about scheduling applications, see Scheduling a PowerFlow
Application.

TIP: You do not need to schedule or run the "Process and Cache Skylar One Events" application, as
that is triggered by the "ServiceNow: Add/Update/Clear Event" Run Book Action in Skylar One.

Removing Lock Documents

The "Remove Lock Documents" application lets you remove the stale lock documents in Couchbase that
were created by the "Process and Cache Skylar One Events" application. SciencelLogic recommends that
you schedule the application every five minutes with the default configurations. Fifty thousand lock
documents are removed in every application run. This could take, for example, an hour and 30 minutes
when removing one million lock documents. Running this application will not impact other applications
running in PowerFlow.

Does this application needs to be run in all systems?

The previous versions of the "Process and Cache Skylar One Events" application generated stale lock
documents, so you might need to schedule this application to clean up those stale documents. To confirm
that they are present in your system, navigate to the Couchbase user interface (https://<powerflow_
IP>:Port 8091), go to the [Bucket] tab, and check the ltems column for the content bucket. This value
should be around 3,000 or less if no stale lock documents are present. If the number is higher and keeps
growing,you should run the the "Process and Cache Skylar One Events"application.
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Will the stale lock documents still be created?

No. The "Process and Cache Skylar One Events" application uses a Redis lock as of version 1.2.1 of the
ServiceNow Events SyncPack, which cleans the locks that have been set. As of version 1.2.1, PowerFlow
will not create any more stale lock documents in Couchbase or Redis.

Configuring the Remove Lock Documents Application

To configure the "Remove Lock Documents" application:

1. Onthe Applications page of the Skylar Automation user interface, click the Filter icon (=) at the top
right of the SyncPacks page and select Show Hidden Applications to show all of the applications.

2. Open the "Remove Lock Documents" application and click [Configure]. The Configuration pane for
that application appears.

3. From the Configurations drop-down, select the same configuration object you aligned to the
"Process and Cache Skylar One Events" application.

If for some reason the lock documents need to be deleted in less runs, you can increase
the high_limit parameter, but be advised that the application can take longer than ~4
minutes(50K) to run, since more documents will be marked for deletion in one run. This
can also cause more overhead in the database.

4. Click [Save] to align that configuration object with the "Remove Lock Documents" application. You
do not need to edit any other fields for that application.

5. Schedule the application to run every five minutes, if the default parameters were not changed. For
more information about scheduling applications, see Scheduling a PowerFlow Application.

IMPORTANT: After all of the stale lock documents are removed, you need to remove the schedule.
You can check the application logs to see if any more lock documents are deleted, and the
message "0 documents were deleted successfully” will display in the logs when no more
lock documents exist. You can also check in the Couchbase user interface
(https://<powerflow_IP>:Port 8091) to confirm that the number of lock documents is
correct.

Additional Considerations for Multiple Skylar
OneSystems

If you are using this SyncPack with multipleSkylar One systems to monitor events from a
single ServiceNow instance, you will need to review this section to ensure your systems are properly
configured.
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Using Multiple Skylar Automation Configuration Objects

The "ServiceNow: Add/Update/Clear Event" run book action requires you to create a unique configuration
object for each Skylar One system. Each Skylar One system must have a unique region value in their
corresponding configuration object.

For more information, see Creating a Configuration Object for Event Sync.

Configuring Skylar Automation Applications

The following Skylar Automation applications were updated to prevent multiple Skylar One systems from
editing the same ServiceNow event at the same time.

Process and Cache Skylar One Events

The "ServiceNow: Add/Update/Clear Event" run book action triggers this application whenever a Skylar
One event is created. In the case where multiple Skylar One systems are syncing an event with a single
ServiceNow event, the application will be "locked" to protect against unwanted behavior in ServiceNow
caused by constantly posting events.

The lock in this application is unique to the event's message key, with the region prepended. The
message key is set in the message_key_template parameter in the Input Parameters section of the
"ServiceNow: Add/Update/Clear Event" run book action. For more information, see Customizing the
Snippet Code in the Input Parameters Pane.

The "Process and Cache Skylar One Event" step will fail if an event with a matching message key is trying
to be written to the cache at the same time as another event. In other words, two events with the same
message key cannot be processed and put into the cache at the exact same time.

The length of the lock is tied to the lock_timeout parameter on the Configuration tab for this application,
which specifies how long Skylar Automation should wait if the application has not completed before
running again. The default is lock timeout is 25 seconds, and you can edit this value on the Configuration
tab if needed. The lock timeout gives ServiceNow time to process the data from the event.

To retrieve the number of events in the cache, run the following command:

select count (*) from logs where meta().id like "SL1 EVENTS%"

To delete all events from the cache, run the following command:

delete from logs where meta().id like "SL1 EVENT%"

Sync Cached Skylar One Events to ServiceNow

The lock created in this application is tied the ServiceNow hostname to protect against unwanted behavior
in ServiceNow caused by constantly posting events. This spacing gives ServiceNow time to process the
events. The lock is released when PowerFlow gets a response from ServiceNow on the post, or the
timeout is reached.

The length of the lock is tied to the lock_timeout parameter on the Configuration tab for this application,
which specifies how long Skylar Automation should wait if the application has not completed before
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running again. The default is lock timeout is 25 seconds, and you can edit this value on the Configuration
tab if needed. The lock timeout gives ServiceNow time to process the data from the event.

"save key": "SL1 EVENT+S${appvar.region}+%"

Sync Alert Details from ServiceNow to Skylar One Events

The lock created in this application is tied the ServiceNow hostname to protect multiple API calls from
ServiceNow, as this call will increase in time as the number of events grows. The alerts are pulled by
region from ServiceNow. The lock is released when Skylar Automation gets a response from ServiceNow
on the GET API call, or the timeout is hit. This is a redis lock with no upper limit.

Scheduling Considerations and Options

Limitations

Event Sync relies on receiving a response from ServiceNow to update back to Skylar One. Sending
multiple payloads at the same time, such as in Option 2, below, causes inconsistency and long completion
times in ServiceNow processing.

The processing put in between writing directly to the target table, such as large table lookups, or other
custom actions, will impact the number of records that Skylar Automation is able to send over.

Also, when sending a batch of 200 events, some customers' custom ServiceNow endpoint can take 108
seconds to complete processing. This means that if Skylar Automation sends more than 200 events in a
minute, ServiceNow will become backlogged, becauase the processing time takes longer than how often
Skylar Automation is posting.

As a result, if the overall throughput of events from Skylar One is more than 200 a minute, events could
potentially continue to get backlogged and may never get processed by ServiceNow until throughput is
reduced.

Option 1: Staggered Schedules

In a multiple-stack setup using an "out-of-the-box" version of the "ServiceNow Events" SyncPack, if all the
events are going to the same ServiceNow instance, then you cannot run each stack every minute,
because the lock is not region-specific.

One option is to run the stacks with separate queues, staggered every minute, meaning that each stack
gets posted every 5 minutes.

Pros:
» Optimized process that ensures no possibility of SNOW ever being overloaded.

» Ensures complete separation of event queues between Skylar One stacks. An event flood from one
Skylar One will not affect or delay eventing from any other stack

Con:
e Events are sent only every 5 minutes per stack.

Option 2: Separate Queues, Send All Events Every Minute
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This option involves modifying the lock of the "Sync Cached Skylar One Events to ServiceNow"
application to be the region instead of the ServiceNow hostname.

Pros:
e Events are sent every minute.

» Due to the separation of queues between SL1s, an event flood from one Skylar One will not affect or
delay eventing from other stacks.

Cons:

» Sending multiple payloads of events to ServiceNow at the same time is known to cause performance
delays, and inconsistencies.

» Might cause ServiceNow to not complete processing before the next minute run, creating a backlog.

» Might also cause invalid data.

Option 3: One Queue, Send All Events Every Minute

Pros:
« Events sent every minute
Cons:
» Possibility of an event flood from one Skylar One to impact other SL1s.

 [f there are in total more than 200 events from all stacks, ServiceNow will take more than one minute
to respond, meaning that the next payload will not be received until after that or the lock timeout
expires.

« A backlog of events from one Skylar One might cause events from other SL1s to be delayed in
processing.

Summary of Options and Benefits

With the consideration of the current custom ServiceNow API endpoint, the following table presents
options and considerations:

Implementation + Event Frequency Possibility for increased  Possibility for one

scheduling ServiceNow race stack event flood to
condition/delay impact another

Option 1: Staggered runs, |4 minutes perstack (1 [No No
SL-recommended timing | stack worth of events
every minute)

Option 2: Separate queue |1 minute per stack (all |Yes No
runs every minute) events every minute)

Option3: Single queue 1 minute per stack (all |No Yes
consolidated event events every minute)

pushing
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Chapter

4

Troubleshooting the Events SyncPack

Overview

This chapter includes troubleshooting resources and procedures to use with the "ServiceNow Events"
SyncPack.

This chapter covers the following topics:
Initial Troubleshooting StePS ... e 53

Resources for Troubleshooting ... ...

52



Initial Troubleshooting Steps

Skylar Automation acts as a middle server between data platforms. For this reason, the first steps should
always be to ensure that there are no issues with the data platforms with which Skylar Automation is
talking. There might be additional configurations or actions enabled on ServiceNow or Skylar One that
result in unexpected behavior. For detailed information about how to perform the steps below, see
Resources for Troubleshooting.

Skylar Automation

1.

Run docker service 1s onthe Skylar Automation server:
¢ Note the Docker container version.
¢ Verify that the Docker services are running.
If a certain service is failing, make a note of the service name and version.

If a certain service is failing, run docker service ps <service name>to see the historical
state of the service and make a note of this information. For example: docker service ps
iservices contentapi.

Make a note of any logs impacting the service by running docker service logs <service
name>. For example: docker service logs iservices couchbase.

ServiceNow

1
2
3.
4

Make a note of the ServiceNow version and SyncPack version, if applicable.
Make a note if you are running a ServiceNow certified application or a Service Graph SyncPack.
Make a note of the SyncPack application that is failing in Skylar Automation.

Make a note of what step is failing in the application, try running the application in debug mode, and
capture any traceback or error messages that occur in the step log.

Resources for Troubleshooting

This section contains port information for Skylar Automation and troubleshooting commands for Docker,
Couchbase, and the Skylar Automation API.

Useful Skylar Automation Ports

53

https://<IP of Skylar Automation>:8091. Provides access to Couchbase, a NoSQL database for
storage and data retrieval.

https://<IP of Skylar Automation>:15672. Provides access to the RabbitMQ Dashboard, which you
can use to monitor the service that distributes tasks to be executed by Skylar Automation workers.
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 https://<IP of Skylar Automation>/flower/workers. Provides access to Flower, a tool for monitoring
and administrating Celery clusters.

 https://<IP of Skylar Automation>:314 1. Provides access to the pypiserver service. which you can
use to see if SyncPacks have been correctly uploaded to Devpi container.

IMPORTANT: Port 5556 must be open for both Skylar Automation and the client.

Helpful Docker Commands

Skylar Automation is a set of services that are containerized using Docker. For more information about
Docker, see the Docker tutorial.

Use the following Docker commands for troubleshooting and diagnosing issues with Skylar Automation:

Viewing Container Versions and Status

To view the Skylar Automation version, SSH to your instance and run the following command:

rpm -ga | grep powerflow
To view the individual services with their respective image versions, SSH to your Skylar Automation
instance and run the following command:

docker service 1ls

In the results, you can see the container ID, name, mode, status (see the replicas column), and version
(see the image column) for all the services that make up Skylar Automation:

Restarting a Service

Run the following command to restart a single service:

docker service update --force <service name>

Stopping all Skylar Automation Services

Run the following command to stop all Skylar Automation services:

docker stack rm iservices
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Restarting Docker

Run the following command to restart Docker:

systemctl restart docker

NOTE: Restarting Docker does not clear the queue.

Diagnosis Tools

Multiple diagnosis tools exist to assist in troubleshooting issues with the Skylar Automation platform:

» Docker PowerPack. This PowerPack monitors your Linux-based Skylar Automation server with SSH
(the Skylar Automation ISO is built on top of an Oracle Linux Operating System). This PowerPack
provides key performance indicators about how your Skylar Automation server is performing. For
more information on the Docker PowerPack and other PowerPacks that you can use to monitor
Skylar Automation, see the Using Skylar One to Monitor Skylar Automation.

» Flower. This web interface tool can be found at the /flower endpoint. It provides a dashboard
displaying the number of tasks in various states as well as an overview of the state of each worker.
This tool shows the current number of active, processed, failed, succeeded, and retried tasks on the
Skylar Automation platform. This tool also shows detailed information about each of the tasks that
have been executed on the platform. This data includes the UUID, the state, the arguments that
were passed to it, as well as the worker and the time of execution. Flower also provides a
performance chart that shows the number of tasks running on each individual worker.

e Debug Mode. All applications can be run in "debug" mode via the Skylar Automation API. Running
applications in debug mode may slow down the platform, but they will result in much more detailed
logging information that is helpful for troubleshooting issues. For more information on running
applications in Debug Mode, see Retrieving Additional Debug Information.

« Application Logs. All applications generate a log file specific to that application. These log files can
be found at /var/log/iservices and each log file will match the ID of the application. These log files
combine all the log messages of all previous runs of an application up to a certain point. These log
files roll over and will get auto-cleared after a certain point.

e Step Logs. Step logs display the log output for a specific step in the application. These step logs
can be accessed via the Skylar Automation user interface by clicking on a step in an application and
bringing up the Step Log tab. These step logs display just the log output for the latest run of that
step.

» Service Logs. Each Docker service has its own log. These can be accessed via SSH by running the
following command:

docker service logs -f <service name>

Retrieving Additional Debug Information (Debug Mode)

The logs in Skylar Automation use the following loglevel settings, from most verbose to least verbose:
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10. Debug Mode.

20. Informational.

30. Warning. This is the default settings if you do not specify a loglevel.
e 40. Error.

WARNING: If you run applications in Debug Mode ("loglevel": 10), those applications will take longer
to run because of increased I/0 requirements. Enabling debug logging using the following
process is the only recommended method. SciencelLogic does not recommend setting
"loglevel": 10 for the whole stack with the docker-compose file.

To run an application in Debug Mode using the Skylar Automation user interface:
1. Select the Skylar Automation application from the Applications page.

2. Hover over the [Run] button and select Custom Run from the pop-up menu. The Custom Run
window appears.

3. Select the Logging Level. Debug is the most verbose and will take longer to run.

4. Specify the configuration object for the custom run in the Configuration field, and add any JSON
parameters in the Custom Parameters field, if needed.

5. Click [Run].
To run an application in Debug Mode using the API:
1.  POST the following to the API endpoint:

https://<Skylar Automation IP>/api/vl/applications/run

2. Include the following in the request body:

{

"name": "<application name>",
"params": {

"loglevel": 10

}
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After running the application in Debug Mode, review the step logs in the Skylar Automation user interface
to see detailed debug output for each step in the application. This information is especially helpful when
trying to understand why an application or step failed:

= Application @ Help Notifications 105 isadmin v SCIénCGLOgiC

L5 Delete Devices From SL1 # Open Editor = Reports ~ Timeline o Replay > Run % Configure
Q
& $
Pull Affected Device Info
from SL1(GQL) C
[ Pull Disabled Devices from Verify Device Delete .
VCUGinSL1 Requests @ DeletaDovices
or o Pull i
from SL1 (MySQL)
»
&
2= STEPLOG STEP DATA 0 copy || ® pownload I3 Full screen
Module 1. Date (UTC-4) /- LogLevel 1 Message
| Basesten Aug 29,2023 10:48:21, 347 INFO i Disabled Devices from VCUG n SL1 - step: DisabledDevices.py [a]
| ipaas_logger Aug 29,2023 10:48:21, 348 FLOW Start Pull Disabled Devices from VCUG in SL1 (]
| ipaas_logger Aug 29,2023 10:48:21, 355 FLOW Step Pull Disabled Devices from VCUG in SL1 still failed after O retries [n]
~ | Basesten Aug 29,2023 10:48:21, 357 ERROR Traceback (most recent call last): File "usr/local/lib/pythy ite-pack BaseStep.. (s}
Traceback (most recent call last): File "usr/localli i i ", line 601, in execute_step selfretry_step , exc=err, File " i ite-p p /,line 961, in
retry y(File 7 i *,line 706, in retry raise_with File "/usr i i 7, line 579, in execute._step selfexecute() File
“Just/local/li ite-packages/ip: " line 51, in inner_execute execute = ) File” v /b i i i /_cmdb s
/PullAndProcessDisabledDevices.oy" line 69. in execute raise Missi i i i tions Missis i target veus|s reauired butis in either delete devices ori

You can also run an application in debug using curl via SSH:

1. SSHto the Skylar Automation instance.

2. Run the following command:
curl -v -k -u isadmin:<password> -X POST "https://<your
hostname>/api/vl/applications/run"

-H 'Content-Type: application/json' -H 'cache-control: no-cache' -d

'{"name":
"interface sync sciencelogic to servicenow","params": {"loglevel":

10}}"
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